
We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

 Microsoft
Exam Questions PL-200

Microsoft Power Platform Functional Consultant

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

About Exambible

Your Partner of IT Exam

Found in 1998

Exambible is a company specialized on providing high quality IT exam practice study materials, especially Cisco CCNA, CCDA,

CCNP, CCIE, Checkpoint CCSE, CompTIA A+, Network+ certification practice exams and so on. We guarantee that the

candidates will not only pass any IT exam at the first attempt but also get profound understanding about the certificates they have

got. There are so many alike companies in this industry, however, Exambible has its unique advantages that other companies could

not achieve.

Our Advances

* 99.9% Uptime

All examinations will be up to date.

* 24/7 Quality Support

We will provide service round the clock.

* 100% Pass Rate

Our guarantee that you will pass the exam.

* Unique Gurantee

If you do not pass the exam at the first time, we will not only arrange FULL REFUND for you, but also provide you another

exam of your claim, ABSOLUTELY FREE!

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

NEW QUESTION 1
- (Exam Topic 1)
A guest asks about the start time of a specific scheduled event and wants to know what the snow conditions will be like during their stay.
You need to determine how to design the chat solution to answer those questions. What should you do? To answer, select the appropriate options in the answer
area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated
Box 1: Load the extracted topic into a variable
Power Virtual Agents uses entities to understand and identify a specific type of information from a user's responses. When saving the identified information to a
variable, a variable type will be associated with it. The variable type is analogous with the entity.
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 2: Create a custom entity
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 2
- (Exam Topic 1)
You need to design the resort portal to meet the business requirements. Which data source should you use?

A. Microsoft Excel
B. Azure SQL Database
C. SQL Server
D. Common Data Service

Answer: A

NEW QUESTION 3
- (Exam Topic 1)
You need to design the resort portal’s email registration process.
Which solutions should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 4
- (Exam Topic 2)
You need to address the executive’s concerns regarding unnecessary data access.
Which security changes should you make? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Assign records to a service account and add the team member doing the verification by using an access team.
When to use access teams
* The teams are dynamically formed and dissolved. This typically happens if the clear criteria for defining the teams, such as established territory, product, or
volume aren’t provided.
* The team members require different access rights on the records. You can share a record with several access teams, each team providing different access rights
on the record. For example, one team is granted the Read access right on the account and another team, the Read, Write and Share access rights on the same
account.
* A unique set of users requires access to a single record without having an ownership of the record. Box 2: Assign records to the QV team when the service
request is completed.
Issues: More employees than are required can access individual client information and continue to have access after a service request is completed.
Management has decided to create a new qualification verification (QV) role to help ensure that clients get the most accurate results. This role examines
completed work to ensure that nothing is missed.
• When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all
the qualifications related to their service requests.
Reference:
https://docs.microsoft.com/en-us/power-apps/developer/data-platform/use-access-teams-owner-teams-collaborat

NEW QUESTION 5
- (Exam Topic 2)
You need to coordinate updates and deployment for managed solutions containing completed work without disrupting the system.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 
Box 1: Deploy a patch with the changes made from the current solution. Scenario:
The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live
date without the other shared components.
Box 2: Deploy a full copy of the original solution using the upgrade option. Then, deploy the new solution by using the update option.
Scenario: All components required for the verification process must be included in a new solution. Corporate security requires that deployments to non-
development environments must be automated using
service accounts.
Managed solutions are used to move customizations from the development environment to other higher-level environments. These solutions are created and
maintained by the power users and provided to internal IT for deployment when they are ready.
Note:
Upgrade This is the default option and upgrades your solution to the latest version and rolls up all previous patches in one step. Any components associated to the
previous solution version that are not in the newer solution version will be deleted. This is the recommended option as it will ensure that your resulting configuration
state is consistent with the importing solution including removal of components that are no longer part of the solution.
Update This option replaces your solution with this version. Components that are not in the newer solution won't be deleted and will remain in the system. This
option is not recommended as your destination environment will differ in configuration from your source environment and could cause issues that are difficult to
reproduce and diagnose.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/update-solutions

NEW QUESTION 6
- (Exam Topic 2)
You create a desktop flow to interact with a certification authority’s website. You need to get data in and out of the desktop flow.
How should you set up the input and output parameters? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Connect by using the Dataverse connector from the desktop flow and retrieve the qualification data. All information sent by clients for services is stored in
Microsoft Dataverse with a model-driven app as the
interface.
Qualification verification
The qualification table contains details about an individual school degree, professional qualifications, and other qualifications that must be verified.
A service request can have one or more Qualification records associated with it.
Record status is pending verification until the initial team member finishes, at which point the member changes the status to Complete.
When all qualification records related to a service request are verified either by manual or automated processes, the results are made available to ADatum
Corporation’s client.
In the rare event that results are questioned, a new service request is created and verified independently of the previous work that took place.
Box 2: Send data from the desktop flow to a cloud flow to update the qualification record. To complete a service request, users perform the following actions:
Send a templated email by using Microsoft Outlook to the client after all qualifications for a service request are checked.
Change the service request status to Completed. Currently, service requests do not indicate when all Qualification records are addressed.

NEW QUESTION 7
- (Exam Topic 2)
You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Apply to each
You can use the Apply to each action to process a list of items periodically. Box 2: Do until
The Do Until control in Power Automate is a loop that repeatedly forces an action until a certain condition becomes true.
Reference: https://docs.microsoft.com/en-us/power-automate/apply-to-each https://blog.enterprisedna.co/do-until-loop-control-in-power-automate/

NEW QUESTION 8
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator.
Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Excel template
B. Entities component of a solution
C. Microsoft Virtual Studio
D. Templates area

Answer: B

Explanation: 
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables

Expand Data, select Tables, select the table you want, and then select the Views area.

 On the toolbar, select Add view. Add view to table

 On the Create a view dialog, enter a name and, optionally, a description, and then select Create. Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 9
- (Exam Topic 3)
A company plans to implement chatbots by using Power Virtual Agents. The company has the following requirements for the bots:
• Users in the accounting department must be able to create a bot for frequently asked questions.
• The support desk users must be able to use the bot.
The users must not be able to change environment parameters in the Microsoft Power Platform environment. You need to configure the permissions for the bots.
Which actions should you implement? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 

NEW QUESTION 10
- (Exam Topic 3)
You create a parent entity and a child entity. The parent entity has a 1:N relationship with the child entity.
You need to ensure that when the owner changes on the parent record that all child records are assigned to the new owner.
You need to configure the relationship behavior type. What should you use?

A. Parental
B. Referential, Restrict Delete
C. Referential
D. Restrict

Answer: A

Explanation: 
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/create-and-edit-1n-relationship A parental table relationship is any 1:N table
relationship where one of the cascading options in the Parental column of the following table is true.
Graphical user interface, application Description automatically generated

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-entity-relationships

NEW QUESTION 10
- (Exam Topic 3)
You are creating tables for use with Microsoft Power components.
The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?

A. Power Apps
B. Default solution
C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C

NEW QUESTION 12
- (Exam Topic 3)
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You are designing a desktop user interface (Ul) flow. The Ul flow automates legacy software.
You need to prepare data for transfer to a Microsoft SharePoint list.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/inputs-outputs-desktop#use-outputs-to-extract-inform

NEW QUESTION 15
- (Exam Topic 3)
You are a consultant. A client asks you to remove several solutions in one of their Microsoft Dataverse environments
The client wants to know what effect removing the solutions will have on the rest of the system. You need to explain the results of removing the solutions.
Which components be affected? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 18
- (Exam Topic 3)
You are a Dynamics Sales administrator for a car dealership. The dealership uses only out-of-the-box functionality. When a new car is sold, the salesperson uses
a Word template to generate a letter from the quote to thank the customer.
You need to determine if you can revise the template. Which Word template change can you make?
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A. Add the Discount field conditionally.
B. Format the table to have alternating color rows.
C. Format the Created On field to a long date format.
D. Add the address of the customer.D18912E1457D5D1DDCBD40AB3BF70D5D

Answer: D

NEW QUESTION 21
- (Exam Topic 3)
You plan to create a dataflow to import data into Microsoft Dataverse by using Power Query. The dataflow has the following requirements:
• A table of aggregated data must be created in dataflow storage.
• A unique identifier must be created for the table.
You need to configure the dataflow.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection Is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 23
- (Exam Topic 3)
A company plans to implement a voice-enabled Power Virtual Agents bot. The company has the following requirements for the bot:
• Recognize when a caller states Tennis or any variation of the word.
• Provide options when a caller states the name of a sport. You need to configure the bot.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 26
- (Exam Topic 3)
You plan to implement Microsoft Dataverse.
You must track changes for two columns in the Account table. You must maintain a historical log of changes for the two columns and track only what is necessary.
You configure the appropriate organization settings.
You need to configure the system to track changes for the two columns.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable auditing for the Account table.
B. Enable auditing for the two specific columns.
C. Enable change tracking for the Account table.
D. Enable change tracking for the two specific columns.

Answer: AB

Explanation: 
By setting the IsAuditEnabled property of a table’s definition and the IsAuditEnabled property of each desired column’s definition to true, data changes to records
of those tables can be logged by the platform.
Note: There are three levels where auditing can be configured: organization, table, and column. The organization level is the highest level, followed by the table
level, and finally the column level. For column auditing to take place, auditing must be enabled at the column, table, and organization levels. For table auditing to
take place, auditing must be enabled at the table and organization levels.
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/configure-entities-attributes-auditing

NEW QUESTION 31
- (Exam Topic 3)
You create a report by using Power BI Desktop and a Power BI dataset that is connected to Azure SQL Database.
Multiple groups of employees will use the report.
You need to ensure that each group of employees can see only data that pertains to their group. What should you do?

A. Create and assign file security profiles.
B. Create and assign Common Data Service security roles.
C. Create and assign roles by using row-level security.

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 33
- (Exam Topic 3)
A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.
This app needs to be promoted to the user acceptance testing environment.
You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.
B. Set the Optimized embedding appearance field to true.
C. Publish all changes.
D. Run the solution checker.
E. Clone a solution.

Answer: DE

Explanation: 
The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.
The solution checker analyzes these solution components: Common Data Service plug-ins
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Common Data Service custom workflow activities
Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps
Reference: https://www.eimagine.com/ui/

NEW QUESTION 38
- (Exam Topic 3)
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable Outlook integration
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead enable server-based SharePoint integration. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/set-up-dynamics-365-online-to-use-sharepoint-online

NEW QUESTION 39
- (Exam Topic 3)
A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the
devices and then launch the apps to perform actions.
Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in
the future.
You need to configure the solution to prevent the reported security incidents. What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Set a timeout in the Power Platform admin center.
To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain
signed in the application for the duration of session. The application signs out the user when the session expires. Users need to sign in with their credentials to
return to customer engagement apps.
Note: Configure session timeout

 In the Power Platform admin center, select an environment.

 Select Settings > Product > Privacy + Security.

 Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout

 In the Power Platform admin center, select an environment.

 Select Settings > Product > Privacy + Security.

 Set Session Expiration and Inactivity timeout. These settings apply to all users. Box 2: Enter the restricted file types in the SharePoint admin center.
To block uploading of specific file types

 Go to the Settings page of the new SharePoint admin center,

 Select Sync.
Graphical user interface, text, application Description automatically generated
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 Select the Block upload of specific file types check box.

 Enter the file name extensions you want to block, for example: exe or mp3.

 Select Save.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/user-session-management https://docs.microsoft.com/en-us/onedrive/block-file-types

NEW QUESTION 41
- (Exam Topic 3)
A company uses a canvas app.
Supervisors must approve transactions when a user from the sales department enters a revenue amount that is over $1 million.
You need to configure an approval process without using code. What should you create?

A. Column Expression
B. Power Automate cloud flow
C. Azure Service Bus service
D. Power Apps component framework (PCF) control

Answer: B

NEW QUESTION 44
- (Exam Topic 3)
You configure an alert in Power Bl.
You need to alert users when the value of a tile exceeds a threshold. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/create-reports/service-set-data-alerts

NEW QUESTION 45
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:
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 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use Date and time for Identify in the question
and then add branches that use conditional logic to
determine the age group.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 49
- (Exam Topic 3)
A company is building a Power Virtual Agents chatbot.
Users in the accounting department require access to collaborate with the building of the bot. Users in the sales department require access to only chat with the
bot.
You need to configure the bot.
Which sharing options should you use? To answer, drag the appropriate sharing options to the correct requirements. Each sharing option may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 53
- (Exam Topic 3)
You need to design the FAQ solution to handle unknown responses.
Which component should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
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B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-hand-off

NEW QUESTION 58
- (Exam Topic 3)
You create a new independent software vendor (ISV) solution for a Power Apps app.
The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.
Which element should you configure?

A. Package type
B. Configuration page
C. Marketplace
D. Prefix
E. Version

Answer: D

Explanation: 
A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 61
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Create a custom Age group entity and
synonyms for each individual age in the corresponding item.
Use Age group for Identify in the question.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 63
- (Exam Topic 3)
You attempt to deactivate several currencies in a Microsoft Dataverse environment. You are not able to deactivate one of the currencies.
You need to determine why you cannot deactivate the currency. What is the reason?

A. You are not the currency record owner.
B. The currency is used by an active business process.
C. The currency is the base currency.
D. The currency is used by another record.

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/org-service/web-service-error-codes https://docs.microsoft.com/en-us/power-
platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 65
- (Exam Topic 3)
A company has a portal. Users sign into the portal by using a social media account.
The company wants to replace the existing portal with a Power Apps portal. users must sign up for access to the portal by using a Microsoft account and a unique
invitation code that will be provided to the users.
You need to configure authentication for the home page.
Which values should you use? To answer, drag the appropriate values to the appropriate authentication settings. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
NO NO

NEW QUESTION 66
- (Exam Topic 3)
The app needs to store temporary data
• Each screen must maintain a separate copy of data and pass the data to another screen.
• The app must be able to update separate rows of a table independently. You need to configure variables for the data.
Which variable types should you use? To answer, drag the appropriate variable types to the correct requirements. Each variable type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated with medium confidence

NEW QUESTION 68
- (Exam Topic 3)
A company uses a Power Apps app with Microsoft Dataverse.
The company requires the import of records into Dataverse. Duplicate records in the data must be deleted without user intervention.
You create a duplicate detection rule.
You need to configure the rule for the data import. Which option should you configure?

A. Enable the Templates for Data Import option.
B. Enable the When a record is created or updated option.
C. Disable the Allow Duplicates option.
D. Enable the During data import option.

Answer: D

Explanation: 
When configuring a duplicate detection rule in Power Apps with Microsoft Dataverse, to automatically delete duplicate records during a data import, you should
enable the "During data import" option. This option allows the detection rule to automatically delete duplicates as they are imported into the system, without
requiring user intervention.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/create-duplicate-detection-rule

 https://docs.microsoft.com/en-us/power-platform/admin/data-integration-duplicate-detection 

NEW QUESTION 69
- (Exam Topic 3)
A company uses a canvas app to manage production resources in a specific region. Employees must be at company locations to use the app.
Due to a sudden requirement for employees to work remotely, employees no longer commute to a specific location to conduct their work and cannot access the
canvas app.
You must reconfigure the app to ensure that employees only access the app from a limited number of locations.
You need to restrict access to the app.
Which components should you configure? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/restrict-access-online-trusted-ip-rules

NEW QUESTION 72
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneDrive for Business.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 75
- (Exam Topic 3)
You are customizing a model-driven app for a company. You create a Theme template to ensure the company logo and colors are properly used within these
apps.
The theme must meet the following requirements:

 Updated to add the logo

 Downloaded by the makers to create the app
You need to configure the assets. To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Upload the theme elements as new web resources.
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Each type of icon is stored as a web resource. Create a web resource first and then set the icons to use them. Alternatively, you can add the icon by creating a
new web resource when you define the table properties.
Box 2: Replace an existing UI item's hexadecimal number. Copy and alter the existing theme
The easiest and quickest way to create a new theme is to clone and alter an existing theme. Then save, preview, and publish it.

 Sign in to Power Apps, select Settings icon (upper right), and then select Advanced settings.

 Select Customizations, and then select Themes.

 Under All themes, select the theme you want to clone, such as the CRM Default Theme. Select Clone on the command bar.

 Replace an existing UI item's hexadecimal number, such as the Title Text Color, with the hexadecimal value that represents the color you want.
For example, the CRM Default Theme was cloned and changed using mostly varying shades of green color. The following screenshots show the new colors for
navigation and highlighting. A custom logo was also added that will appear in the upper left corner of an app.

Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 79
- (Exam Topic 3)
You are implementing a model-driven app to support a new line of business. There are several places where automated business logic must be applied. You need
to determine how to apply the business logic.
Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
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Box 1: Business rule
By combining conditions and actions, you can do any of the following with business rules:

 NSE5_FSM-5.2 Set column values

 Clear column values

 Set column requirement levels

 Show or hide columns

 Enable or disable columns

 Validate data and show error messages

 Create business recommendations based on business intelligence. Box 2: Real-time workflow
Real-time workflows:
Graphical user interface, text, application, email Description automatically generated

Box 3: Power Automate instant flow
Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow
button in the mobile app.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-a https://docs.microsoft.com/en-
us/powerapps/maker/data-platform/configure-workflow-steps https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-
automate-and-ho

NEW QUESTION 84
- (Exam Topic 3)
A veterinary office plans to use Microsoft Power Platform to streamline customer experiences. The customer creates a canvas apps to manage appointments.
On the client appointment form, there is a dropdown field for clients to select their type of pet. If a client selects the option Other, a text field must appear so that
staff members can add details about the pet.
You need to create a dynamically visible field. What should you configure?

A. business rule
B. business process flow
C. workflow

Answer: A

Explanation: 
A business rule can be used to configure the visibility of a field based on the value selected in another field. In this case, a business rule could be created to make
the text field for additional pet details visible when the "Other" option is selected in the dropdown field for the type of pet. This can be done by going to the Power
Apps portal, navigating to the Common Data Service, and creating a new business rule for the entity that contains the appointment form. Within the rule, you can
set the visibility of the text field to be dependent on the value selected in the dropdown field. Reference:
https://docs.microsoft.com/en-us/power-platform/model-driven-apps/model-driven-business-rules
It's important to note that the above feature is only available in the PowerApps Model Driven App and not in Canvas App.

NEW QUESTION 89
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25
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 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use age for Identify in the question and then
add branches for each group that use conditional logic.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead, create a custom Age group entity and synonyms for each individual age in the corresponding item. Use Age group for Identify in the question.
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.
To do this, you need to create a custom entity. Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling 

NEW QUESTION 91
- (Exam Topic 3)
A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.
The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.
Which expression should you use?

A. Option A
B. Option B
C. Option C

Answer: C

Explanation: 
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value’],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 92
- (Exam Topic 3)
A company uses Power Apps with Microsoft Dataverse.
The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.
You need to delete some auditing data.
Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table
B. by record
C. between two specified dates
D. by column
E. older than a specified date

Answer: ACE

Explanation: 
* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates"
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs
It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.
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NEW QUESTION 95
- (Exam Topic 3)
You plan to automate several different processes by using Power Automate. Each process has unique characteristics.
You need to recommend components for each process.
Which components should you recommend? To answer, drag the appropriate components to the correct processes. Each component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1: Custom connector (REST API access) 2: Unatteded UI flow

NEW QUESTION 97
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
You need to configure the following automation for the sales team:
* Send an email when the status changes on an Opportunity.
* Text the sales manager when an Opportunity is created.
* Create a Wunderlist task when an Opportunity is open for 30 days.
Which tool should you use for each requirement? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 100
- (Exam Topic 3)
A company uses a model-driven app with Microsoft Dataverse in a single environment
The company requires a canvas app that includes the same data as the model-driven app. You need to create the canvas app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 101
- (Exam Topic 3)
A company uses Dataverse to store the names of contacts. The company uses a shared Microsoft Excel file to collect the data. The company requires that the
contacts be added to Dataverse automatically every day
You need to identify which tools are required to create and perform the import. What should you use? To answer, select the appropriate options in the answer
area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 106
- (Exam Topic 3)
You are designing a chatbot for a sports outlet. You need to complete the chatbot.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Entities
Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs,
such as age, colors, numbers, and names.
With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.
Box 2: Topics
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In Power Virtual Agents, a topic defines a how a bot conversation plays out.
You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 3: Variables
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
For example, you can save a customer's name in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-
topics
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

NEW QUESTION 110
- (Exam Topic 3)
A company uses Common Data Service to manage account and contact information. The company plans to use the Al Builder model to make key business
decision.
You need to integrate prebuilt Al Builder models with Power Automate.
Which models should you use? To answer, select the appropriate option the answer area. NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-sentiment-analysis https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase
https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognition

NEW QUESTION 114
- (Exam Topic 3)
You are using power Automate to create a list of customers from a Microsoft Excel file, The list must contain customers who meet one of the following criteria:

 Sales of less than $500,000.

 Customers who are on credit hold.
You need to create a condition to filter the list Of customers.
How should you complete the filter condition? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application, Word Description automatically generated
Box 1: or
Or: Takes two arguments and returns true if either argument is true. Box 2: equals(item()?['credithold'],'true')
Equals: Returns true if two values are equal.
For example, if parameter1 is someValue, this expression returns true: equals(parameters('parameter1'), 'someValue')
Reference:
https://docs.microsoft.com/en-us/power-automate/use-expressions-in-conditions
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NEW QUESTION 118
- (Exam Topic 3)
You plan to add a Power Apps app to Microsoft Teams.
A Microsoft Dataverse for Teams environment has not been provisioned. You need to create a Dataverse for Teams environment.
Which two actions can you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Create a new environment in the Microsoft Power Platform Admin Center.
B. Create a new app in Teams.
C. Create an app permission policy in the Teams admin center.
D. Install an existing app in Teams.

Answer: BD

NEW QUESTION 121
- (Exam Topic 3)
You need to create a Power Automate desktop flow.
What are two possible ways to create the flow? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Record mouse and keyboard events.
B. Configure a pre-built template.
C. Use pre-built actions.
D. Create models by using Microsoft Visio.

Answer: AC

Explanation: 
C: Desktop flows are used to automate tasks on the Web or the desktop. Using Power Automate you can automate tasks on the desktop as well as the Web.
A: Alternatively, you can use the two legacy methods of creating desktop flows: Windows recorder (V1) and Selenium ID. With these you record mouse and
keyboard events.
Reference:
https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-flow https://docs.microsoft.com/en-us/power-automate/desktop-flows/create-web

NEW QUESTION 125
- (Exam Topic 3)
You are using Power BI to build a dashboard for a company.
You must make the dashboard available to a specific set of users, including employees and five external users. The number of employees that require access to
the dashboard varies, but usually less than 100. Employees and external users must not be permitted to share the dashboard with other users.
You need to share the dashboard with the employees and external users.
Which three actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Create a dynamic distribution lis
B. Add all users to the distribution group and use the list to share the dashboard.
C. Sign into the Power BI servic
D. Open the dashboard and select Share.
E. Enter the individual email address of internal and external users.
F. Sign into Power BI Deskto
G. Open the dashboard and select Share.
H. Clear the Allow recipients to share your dashboard (or report) option.
I. Create a distribution grou
J. Add all users to the distribution group and use the list to share the dashboard.

Answer: BEF

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 130
- (Exam Topic 3)
You plan to create a canvas app.
The app requires a button on the data entry screen that users can select to send an email. You need to configure the app.
What should you create?

A. Business process flow
B. Azure Logic App
C. Power Automate cloud flow
D. Classic workflow

Answer: C

NEW QUESTION 135
- (Exam Topic 3)
You create workflows to automate business processes.
You need to create a workflow that automatically sends emails based on a mail merge template. The workflow must contain the following configurations:

 Run immediately.

 Validate when a condition is met.
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 Perform an action when a condition is met.
To answer, select the appropriate configuration in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 140
- (Exam Topic 3)
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen. You need to implement an action that selects the next screen that the
user sees.
Which event should you handle?

A. OnLoad
B. OnCheck
C. ScreenTransition
D. OnSelect

Answer: D

Explanation: 
 Add navigation
* 1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
* 2. With the arrow still selected, select the Action tab, and then select Navigate.
* 3. The OnSelect property for the arrow is automatically set to a Navigate function.

* 4. When a user selects the arrow, the Target screen fades in.
* 5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
* 6. Navigate(Source, ScreenTransition.Fade)
* 7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

NEW QUESTION 144
- (Exam Topic 3)
You create a Power Virtual Agents chatbot to reduce the number of incoming support calls that require a live person.
The chatbot does not direct users to the correct information. You determine that this is because the chatbot is not able to identify which product a user is referring
to in a conversation.
You need to present a list of products so that users can select the correct product. What should you create?

A. Table
B. Variable
C. Slot filling
D. Entity

Answer: C
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Explanation: 
Slot filling is a natural language understanding concept that means saving an extracted entity to an object. However, in Power Virtual Agents, slot filling means
placing the extracted entity value into a variable.
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 145
- (Exam Topic 3)
You create a Power Virtual Agents bot.
You observe that the bot is not able to recognize input from some users. You need to configure the bot response for unrecognized input from users.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Transfer to an agent.
B. Use a fallback topic.
C. Display a system-defined error message.
D. Connect to a different channel.

Answer: BC

Explanation: 
* B. Use a fallback topic: Power Virtual Agents provides the capability to handle unrecognized inputs by using fallback topics. A fallback topic is a topic that is
triggered when the bot is unable to recognize the user input. You can configure fallback topics by going to the Power Virtual Agents portal, and then select the bot
you want to configure. Then select the "Topics" tab and create a new topic with a fallback trigger. Reference: https://docs.microsoft.com/en-us/power-virtual-
agents/topics-triggers#fallback-triggers
* C. Display a system-defined error message: This is another option to handle unrecognized inputs by displaying a predefined message that inform the user that
the bot was unable to understand their input.

NEW QUESTION 150
- (Exam Topic 3)
A company uses Power Apps.
You create a custom table and configure a child table relationship with the contact table. You need to configure the cascading rules for each action.
Which behavior should you use? To answer, drag the appropriate behaviors to the correct actions. Each behavior may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 155
- (Exam Topic 3)
A user has access to an existing Common Data Service database.
You need to ensure that the user can create canvas apps that consume data from Common Data Service. You must not grant permissions that are not required.
Which out-of-the-box security role should you assign to the user?

A. Environment Admin
B. System Customizer
C. Common Data Service User
D. Environment Maker
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Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/database-security#predefined-security-roles https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/data-platform-create-app

NEW QUESTION 158
- (Exam Topic 3)
You are using the Data import wizard to import records into the account table from a CSV file. The CSV-to-table mapping is as following:
• Name column represents the account and maps to the Account column.
• TIE Parent Name column represents the holding company of the account with subsidiaries underneath Records that are imported into the table are only related
to other records in the file.
You need to configure the import to create the relationship between records. What should you do?

A. Map Parent Name in the CSV file to the Parent Account colum
B. Select Account as lookup criteria
C. Lookup the record IDs Of the records in the ParentAccount colum
D. Add the record IDs new column in the fil
E. Map the new column to the ParentAccount column.
F. Map Parent Name in the file to the Parent Account colum
G. Select Parent Account as lookup criteria
H. Create an alternate key the account table by using the Account Name colum
I. DO not map parent Name in file.

Answer: C

Explanation: 
Add a new column for the self-referential mapping.
Reference: https://docs.microsoft.com/en-us/power-apps/developer/data-platform/import-data

NEW QUESTION 163
- (Exam Topic 3)
A company creates a Power Automate cloud flow for a Power Apps app.
The cloud flow must send a daily email that contains a list of year-to-date (VTD) totals. You need to configure the flow.
Which feature should you use?

A. Parallel branch
B. Loop
C. Condition
D. Wait

Answer: B

Explanation: 
In order to send a daily email that contains a list of year-to-date (YTD) totals, you would need to use a loop in the Power Automate cloud flow. A loop allows you to
repeat a specific set of actions until a certain condition is met. In this case, the loop would be used to iterate through the data for each day, accumulating the totals
for the year-to-date (YTD) and then sending the email at the end of the loop with the accumulated totals.
Here are some references from Microsoft that may be helpful in understanding how to use loops in Power Automate:

 Microsoft docs: Loops in Power Automate

 Microsoft docs: Repeating a flow with a loop

 Microsoft docs: Using the do-until loop in Power Automate

NEW QUESTION 164
- (Exam Topic 3)
You need to embed the FAQbot into the communication solution.
Which actions should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 

NEW QUESTION 167
- (Exam Topic 3)
You have a form that displays a custom field from an entity.
A customer wants to restrict users from filtering on the custom field. You need to prevent users from filtering the field in Advanced Find. What should you modify?

A. Fields in the Edit Filter Criteria option of the Quick Find view
B. the Field Security field on the Field Properties form
C. a searchable field on the Field Properties form
D. Fields in the Add Find Columns option of the Quick Find view

Answer: C

Explanation: 
Reference:
https://community.dynamics.com/365/b/dynamics365apps/posts/kb-understanding-dynamics-365-field-ssearcha

NEW QUESTION 169
- (Exam Topic 3)
A company deploys a chatbot that is embedded in a Power Pages website. The company has the following requirements for the chatbot:
• Azure AD users only must be able to use the chatbot when accessing sensitive data.
• The chatbot must be accessible only from the Power Pages website. You need to recommend a solution that meets the requirements.
Which two options should you recommend? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable Manual authentication.
B. Set up a new channel for the chatbot.
C. Enable Only for Teams authentication.
D. Enable web channel security.
E. Configure a data loss prevention policy.

Answer: DE

NEW QUESTION 170
- (Exam Topic 3)
You are configuring Microsoft Dataverse security. You plan to assign users to teams. Record ownership and permissions will differ based on business
requirements.
You need to determine which team types meet the requirements.
Which team type should you use? To answer, drag the appropriate team types to the correct requirements.
Each team type may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Microsoft Teams team
Dataverse supports two types of record ownership. Organization owned, and User or Team owned. This is a choice that happens at the time the table is created
and can’t be changed. For security purposes, records that are organization owned, the only access level choices is either the user can do the operation or can’t.
For user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or
only the user’s own records. That means for read privilege on contact, I could set user owned, and the user would only see their own records.
Box 2: Access team
An access team doesn’t own records and doesn’t have security roles assigned to the team. The team members have privileges defined by their individual security
roles and by roles from the teams in which they are members. The records are shared with an access team and the team is granted access rights on the records,
such as Read, Write or Append.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/use-access-teams-owner-teams-collaborate

NEW QUESTION 175
- (Exam Topic 3)
A company has a custom website.
You need to embed a Power Virtual Agents chatbot into the website. What should you use?

A. Webpage URL
B. Form ID
C. Bot ID
D. IFrame

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels

NEW QUESTION 180
- (Exam Topic 3)
You are a Dynamics 365 Customer Services administrator. You have a Production instance and Sandbox instance.
Users record Production instance data in the Sandbox instance.
You need to ensure that the users only record data in the Production instance.
Which security function needs to be edited to prevent access to the Sandbox? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 182
- (Exam Topic 3)
A customer tracks events by using a custom entity.
The custom entity includes a custom field for the venue of the events. The customer must be able to display the events by venue in a calendar.
You need to ensure that all events display by venue in the calendar. To which component should you add a control?
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A. Form
B. view
C. Field
D. Chart

Answer: B

Explanation: 
If you use unified interface, you can display any record in a calendar view via the calendar control.

 Go to Settings->Customization->Customize the System

 Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)

 Click the View tab

 Click “Add Control” and select the calendar control.

 Click the dot for every interface from which you want the calendar control to be available.
Reference:
https://crmtipoftheday.com/1206/view-any-dynamics-365-record-on-a-calendar/

NEW QUESTION 185
- (Exam Topic 3)
You create a new solution for a business process.
The business process includes uploading specific file types to a web service.
You need to ensure that the business process works the same way anywhere the solution is deployed. Which option should you use? To answer, drag the
appropriate options to the correct configurations. Each
option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Solution system settings
For Power Apps in Settings > Customizations > Customize the System you can configure email and document management, activate or deactivate processes, and
more.
Box 2: Environment variable
When should Environment variables be used? Some examples include:
When an input parameter needs to change across environments and should not be hard-coded. For example, a URL that points to a different resource in
development and production environments.
If you’re building a solution where your customer is required to provide an input value. Application setup pages.
Incorrect:
A connection reference is a solution component that contains information about a connector. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/advanced-navigation https://powerapps.microsoft.com/en-us/blog/environment-variables-
available-in-preview/

NEW QUESTION 190
- (Exam Topic 3)
You are designing an app for a bank.
You must create entities for the app and configure relationships between entities:
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Which relationship types should you use? To answer, drag the appropriate relationship types to the correct requirements. Each relationship type may be used
once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text Description automatically generated
Box 1: N:1
You add a lookup column with a many-to-one relationship. Box 2: N:N
Box 3: N:1
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-entity-lookup

NEW QUESTION 193
- (Exam Topic 3)
A farm uses a canvas app to manage schedules for planting fields with crop seeds. The farm uses business intelligence to provide recommendations for schedule
changes based on weather data.
You must implement a business rule that changes information for several forms in the canvas app based on business intelligence data.
You need to configure the business rule. Which scope should you use?

A. Table
B. All Forms
C. Form specific

Answer: A

NEW QUESTION 195
- (Exam Topic 3)
You are embedding a Power Apps visual in a Power BI dashboard. External customers must authenticate to have access to the dashboard. You need to configure
the solution.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Set the Power Bl service to authenticate users.
B. Use a table in the Power Bl dashboard.
C. Publish to Power Bl Report Server.
D. Set the Power Bl service to allow anonymous access.
E. Share the Power Apps visual components with external users.

Answer: AE

Explanation: 
Power BI uses Azure Active Directory (AAD) to authenticate users who sign in to the Power BI service, and in turn, uses the Power BI login credentials whenever a
user attempts to access resources that require authentication. Users sign in to the Power BI service using the email address used to establish their Power BI
account; Power BI uses that login email as the effective username, which is passed to resources whenever a user attempts to connect to data. The effective
username is then mapped to a User Principal Name (UPN) and resolved to the associated Windows domain account, against which authentication is applied.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-admin-power-bi-security

NEW QUESTION 200
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- (Exam Topic 3)
A company creates a bot by using Power Virtual Agents.
The company requires the bot to transfer callers to an agent if the bot is unable to recognize a customers request.
You need to configure the bot for the unrecognized information from the customer. Which feature should you use?

A. Fallback workstream
B. Fallback topic
C. Fallback skill
D. Fallback queue
E. Fallback entity

Answer: B

Explanation: 
A Fallback topic is a type of topic in Power Virtual Agents that is used when the bot is unable to understand the customer's request. When a Fallback topic is
triggered, it takes over the conversation and presents the customer with a set of options or a message that allows them to get the help they need. This can include
options such as requesting to speak with an agent, providing feedback, or getting more information about the bot's capabilities. Fallback topic can be configured to
automatically transfer the customer to an agent.
References:

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/fallback

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-topics

NEW QUESTION 201
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Datavserse Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 203
- (Exam Topic 3)
You are designing a Power Virtual Agents chatbot for a store.
You need to teach the chatbot to acknowledge the store's product categories and the variations within specific categories.
You need to create custom entities to provide the chatbot with the knowledge of the product categories. Which features should you use? To answer, select the
appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

Smart match Synonyms Topic
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 204
- (Exam Topic 3)
You are creating a Power Virtual Agents chatbot for a Microsoft Power Platform power apps portal app. The job title of users must be stored automatically when

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

users log in. The job title must always appear in the
chatbot.
You need to configure the job title functionality.
Which mechanism should you use?

A. artificial intelligence
B. variable
C. entity
D. topic

Answer: B

Explanation: 
After enabling the Authentication, you will now have access to Two variables, bot.UserDisplayName
bot.UserId
Reference:
https://powerusers.microsoft.com/t5/Power-Virtual-Agents-Community/Getting-User-Details-To-Use-In-Power

NEW QUESTION 209
- (Exam Topic 3)
A company has a model-driven app.
The app must meet the following requirements:
• Prevent users from saving a record if validation from a custom action fails.
• Query and update a list of records.
You need to configure processes for the app without using code.
Which processes should you use? To answer, drag the appropriate processes to the correct requirements. Each process may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 214
- (Exam Topic 3)
You are creating Power BI reports for a company.
A company that has a model-driven app wants to use Power BI reports within the app. You create the reports. You need to ensure that these reports are available
within the app.
Which two actions should you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Share the Power Bl report to all users.
B. Add the Power Bl report to the Site Map dashboards.
C. Create a PCF file.
D. Use the native reports in model-driven apps.
E. Add the Power Bl report to a dashboard in the model-driven app.

Answer: BE

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/add-powerbi-visual 

NEW QUESTION 218
- (Exam Topic 3)
A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity
to streamline the prospect management process.
You add a field named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records
based on the selected category. Users can switch to any other newly configured business process flows but must not use BPFA.
You need to configure the solution.
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What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.
B. Deactivate BPFA.
C. Use a business rule to prevent users from switching to BPFA.
D. Change the display order of the business process flows to move BPFA to the bottom of the list.

Answer: AB

NEW QUESTION 221
- (Exam Topic 3)
The sales manager receives a list of leads from a partner company monthly. The field names that are provided do not match the fields in Dynamics 365. A data
map does not exist.
You need to import the leads without changing the data from the partner company. What should you do?

A. Create a data map in Data Management.
B. Add a template for Import Data.
C. Use Import Field Translations.
D. Create a data map on the first import by using the Import Data wizard.

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/basics/import-accounts-leads

NEW QUESTION 225
- (Exam Topic 3)
A company uses a model-driven app for customer support. The company has the following requirements for the app:
• Send an email in real-time to customers when they enter their email address.
• Send an email to customers at the same time every day for cases that are open for more than 24 hours. The solution should require the least amount of
customization.
You need to configure the model-driven app. Which components should you use?

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 229
- (Exam Topic 3)
A company’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.
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You need to provide a solution for each requirement.
Which solutions should you provide? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Add a Kanban control.
The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.
Box 2: Add both controls to the My Opportunities view.

 Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so
salespeople can use the Kanban views.The Kanban control works only on the Opportunity and Activity entities.

 If you use unified interface, you can display any record in a calendar view via the calendar control.
- Go to Settings->Customization->Customize the System
- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)
- Click the View tab
- Click “Add Control” and select the calendar control.
- Click the dot for every interface from which you want the calendar control to be available.
Box 3: Use a List view
opportunities in Dynamics 365 Sales
Reference:
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave1/dynamics365-sales/work-opportunities- https://crmtipoftheday.com/1206/view-any-
dynamics-365-record-on-a-calendar/
https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-cod

NEW QUESTION 230
- (Exam Topic 3)
A company has a model-driven app that uses Microsoft Dataverse.
Users need to add an alternate phone number when entering their account information. The users also require a list that displays the customers that do not have
an alternate phone number.
You need to enable the required features.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or
scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 234
- (Exam Topic 3)
You manage the Dynamics 365 environment for a company.
You need to ensure that there are no leads for a customer before you create a new opportunity for the customer.
How can you use duplicate detection rules to achieve this goal? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 237
- (Exam Topic 3)
You configure and test a user interface (Ul) flow. You plan to run the flow as a scheduled flow.
The Ul flow must run on a Windows 10 device. As part of process automation, the Ul flow must sign into the Windows 10 device with the credentials for a user
account named User1.
You need to ensure that the flow runs during non-peak hours and requires no physical user intervention. What should you do?

A. Ensure that all user sessions are signed out except for locked user sessions.
B. Ensure that the User1 account has an active user session on the device.
C. Ensure that all user sessions are signed out.
D. Ensure that there are no active user sessions on the device.

Answer: D
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Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/run-ui-flow

NEW QUESTION 242
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
A user must be able to view system posts and activities in a dashboard. You need to create the dashboard for the user.
Which components should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Timeline
The timeline helps agents see all customer interaction history across channels, personnel, and the support lifecycle. The timeline is used across Dynamics 365
applications to capture activities like notes, appointments, emails, tasks, and more, to ensure that all interactions with the customer are tracked and visible over
time. Agents use the timeline to quickly catch up on all of the latest activity details with the customer to provide the most personalized support experience.
Box 2: Lists Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/customer-service-hub-user-guide-timeline-adm

NEW QUESTION 244
......
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